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Introduction to Branding 

The Office of the Assistant Secretary for Preparedness and Response’s (ASPR) brand is our 
unique promise of value we make to our stakeholders. Any contact that anyone has with ASPR 
– whether it is the web site or social media, email, presentation, publications, or interactions with 
staff – is an opportunity to demonstrate ASPR’s value and build trust in our brand. A brand is 
more than just a logo. It is our actions, content, and messaging that speak directly to the 
promise we make to our stakeholders. Branding helps build trust and motivate action, engage 
more effectively with stakeholders, create a positive image of our mission, secure funding from 
appropriators, establish credibility as experts and thought leaders, create internal unity and a 
sense of shared purpose, and establish a platform to guide communications.  

ASPR Mission & Key Messages 

ASPR’s mission is to save lives and aid the nation in overcoming the potential health impacts of 
national security threats. In an increasingly complex and unpredictable world, ASPR leads U.S. 
medical and public health capabilities to be prepared for, respond to, and recover rapidly from 
the health effects of disasters and other public health emergencies.  

ASPR also serves as the principle advisor to the Secretary of the U.S. Department of Health 
and Human Services (HHS) on all matters related to federal public health and medical 
preparedness and response. This role includes coordinating policies that drive health security 
and overseeing the Secretary’s Operation Center as the central hub for health emergency 
response operations. 

To meet this mission, ASPR partners with hospitals and healthcare coalitions; biotech and 
pharmaceutical companies; community organizations; foreign government counterparts; and 
state, local, tribal, and territorial (SLTT) governments across the country to improve readiness 
and response capabilities. 

ASPR is focused on three key priorities: 

Respond well and quickly emerge from the COVID-19 pandemic 

ASPR leads the ongoing coordination of the COVID-19 response across HHS. To make sure 
ASPR doesn’t lose the capability developed during COVID, ASPR is extending capabilities in 
the areas of logistics, public health and medical surge operations, and medical countermeasure 
development and distribution.  

Restore resources and capabilities diminished during the pandemic 

ASPR is actively restoring and strengthening capabilities depleted during the pandemic such as 
the Strategic National Stockpile (SNS) and securing the public health supply chain. 

Preparing for future emergencies 

ASPR is constantly scanning the horizon to prepare for whatever may come next, whether 
natural or manmade. In collaboration with partner organizations, ASPR in leading the 
development of policies and frameworks that guide operations to enable ASPR to better prepare 
for, respond to, and recover from disasters and emergencies. 
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ASPR Logo 

The ASPR logo was approved for use in 2012. The logo is the single, most visible 
representation of our organization and is a key element in our brand identity. It immediately 
identifes ASPR to the world, making it one of our most valuable organizational assets.  

The logo is designated for display on all information products regardless of the medium. Any 
use of the logo for external purposes must by cleared by the Division of Communications.  

Prohibited Uses of the ASPR Logo 

The logo is not to be used to promote private-sector products, organizations, or their endeavors. 
It shall never be displayed or presented in a manner that suggests that ASPR endorses one 
product or project over another without written permission from the Division of Communications.  

Downloadable Files 

The ASPR logo is available in two formats: with and without the words “Assistant Secretary for 
Preparedness and Response.” Always use the logo with the wording unless the logo is being 
used as part of a larger graphical element or is being used where the ASPR acronym is clearly 
defined elsewhere within the document or graphical element. The ASPR logo with words can be 
downloaded from the ASPR Portal Branding Site. Contact the Division of Communications to 
obtain the ASPR logo without words. 

Both high- and low-resolution versions in three formats: JPG, PNG, and EPS are provided: 

• JPG (short for Joint Photographic Experts Group) is a computer file format for the 
compression and storage of digital images. This is the most commonly used format for 
inserting the logos into your document. It has a white background. 

• PNG (short for Portable Network Graphics) is a graphic file format similar to a jpg except 
it has a transparent background. This format is used to insert a white logo on a dark 
background, for example. 

• EPS (short for Encapsulated PostScript) is a vector file. It is the best choice for high-
resolution printing of illustrations. An illustration program, such as Adobe Illustrator or 
CorelDRAW, is needed to create or edit an EPS file. These file formats cannot be 
inserted into Microsoft programs. 

Logo Reproduction and Distribution 

The ASPR logo is to be reproduced only from art supplied by the Division of Communications. 
Do not attempt to recreate the logo in any manner. Do not provide copies of the logo art to 
external parties without the approval of the Division of Communications. 

Color 

The logo is always produced in one color. ASPR blue (RGB: 21, 81, 151) is the preferred 
presentation of the logo. When color production is not an option, the logo is black when placed 
on a light background and white when placed on a color or dark background. The image below 
shows appropriate and inappropriate placement options. 

mailto:ASPRCOMMS@hhs.gov?subject=Logo%20usage
mailto:ASPRCOMMS@hhs.gov?subject=Logo%20usage
https://asprportal.hhs.gov/io/ea/communications/branding/Pages/templates-and-logos.aspx
mailto:ASPRCOMMS@hhs.gov?subject=Logo%20usage
mailto:ASPRCOMMS@hhs.gov?subject=Logo%20usage
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Figure 4: Examples of Proper and Improper Logo Placement for Visibility 

 

Incorrect Use 

The logo’s proportions should never be altered, nor should special effects be applied. This 
includes pinching, pulling, pushing, or hitting. The image below shows examples of what not to 
do with the ASPR logo.  

 

 

Figure 3: Examples of Effects that Cannot be Applied to the ASPR Logo 

 

Clear Space 

As the primary symbol of ASPR, the logo should stand out from other graphic elements. The 
logo should always be surrounded with a minimum area of clear space equal to the width of 
ASPR’s letter “R.” 
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Figure 2: Illustration of Clear Space around the ASPR Logo 

 

Position and Placement 

The logo is designated for display on all information products ASPR produces. Placement at the 
top or bottom of the document is determined by the template being used.  

Cobranding  

When used with the HHS logo, the ASPR logo is placed to the right of the HHS logo. They can 
be placed either in opposite corners or side by side, while considering clear space rules. When 
the ASPR logo is used with the HHS logo and subordinate program logos, the order from left to 
right is HHS, ASPR, and then subordinate program logo. Subordinate logos include BARDA, 
NDMS, SNS, and MRC. No other logos are authorized. 

When co-branding products with other federal agencies, place logos in alphabetical order. The 
lead federal agency logo should appear first with the remaining logos in alphabetical order or as 
dictated by the situation. 

To request cobranding permission, contact the Division of Communications.  

Note: When branding a product where ASPR is acting on behalf of the Secretary for Health and 
Human Services, such as responding to an HHS mission, the HHS logo should be used with the 
ASPR logo. 

ASPR Color Pallet 

When a brand repeatedly markets with the same color, it strengthens brand awareness. 
Primary colors help consumers to quickly identify a brand. These are the core colors of the 
brand and are commonly incorporated into a company’s logo.  

Secondary colors highlight and compliment the primary color and can be used to highlight key 
facts or figures in a document or PowerPoint or used to create shapes, SmartArt objects, 
infographics, charts, callouts, tables, and icons. Sometimes a design requires more than the 
primary and secondary colors. This is especially true for content rich brochures, posters, and 
multiple data point tables and graphs. For these purposes only, we have added several 
additional accent colors to distinguish data elements in charts and graphics only. To see these 
colors in action, check out the Word and PowerPoint templates referenced below.  

mailto:ASPRComms@hhs.gov?subject=Logo%20Use
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All templates for Word documents, PowerPoint presentations, fact sheets, postcards, and 
posters should utilize black body text. Headers should use one of the dark blue from the primary 
palette provided below.  

All documents produced in ASPR must have appropriate color contrast to comply with federal 
accessibility requirements.  Please be sure to use white text and black text on the 
corresponding background color as shown on the palettes below to ensure sufficient color 
contrast in all ASPR work products. As noted above, the blue text from the primary color pallet 
may be used on a white background when being used as a header. 

Primary Color Palette 

 
 

RGB:  [21, 81, 151] 
HEX:  #155197 

CYMK: [86, 46, 0, 41] 

  
 

RGB:  [6, 46, 97] 
HEX:  #062e61 

CYMK:  [94, 53, 0, 62] 

 

 
Secondary Color Palette 

RGB: [170, 100, 4] 
HEX:  # AA6404  

CYMK: [27, 63, 100, 14] 

 

RGB: [251, 208, 152] 
HEX: # fbd098 

CMYK: [1, 20, 44, 0] 

   

RGB:  [153, 0, 0] 
HEX:  #990000 

CYMK:  [0, 100, 100, 40] 

 

RGB: [254, 236, 234] 
HEX: #feecea 

CYMK: [0, 8, 4, 0]  

   

RGB 36, 119, 189] 
HEX:  #2477bd 

CYMK: [83, 49, 0, 0] 

 

RGB:  [221, 232, 244] 
HEX:  #dde8f4 

CYMK: [9, 5, 0, 4] 
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Accent Color Pallet: Neutral Colors  

RGB [50, 50, 50] 
HEX:  # 323232 

CYMK: [70, 63, 62, 59] 

 

RGB: [230, 230, 230] 
HEX:  #e6e6e4 

CYMK: [9, 6, 8, 0] 

 

Accent Color Pallet: Bright Colors for Charts and Graphs Only 

 

RGB: [96, 72, 120] 
HEX: #604878 

CYMK: [71, 80 27, 10] 
 

  
 

RGB: [78, 133, 66] 
HEX: #4E8542 

CYMK: [73, 27, 96. 11] 

 

Color Pallet Key 

RGB: RGB is for digital use including television. For this format, RGB combines red, green, and 
blue to create a spectrum of colors. For this format, black is 0,0,0 and white is 256,256,256. 

HEX: HEX code is the key to unlock web and digital design like HTML, CSS and SCSS. Colors 
are represented in a 6 number and/or letters combination. For example, black is #000000 and 
white is #ffffff. 

CMYK: For print use, CMYK is ideal. Tiny dots of cyan, magenta, yellow and black are 
overlapped to blend colors. Because of limitations with a printer, not all colors can be produced. 
Black is represented as 0,0,0,100 and white is 0,0,0,0.  

Branded Templates and Correspondence 

ASPR has templates available that comply with brand standards defined in this guide. All staff 
should use these templates when developing reports, documents, fact sheets, certificates, 
postcards, posters, flyers, and PowerPoint presentations. If your program needs materials 
beyond the templates provided, send a request for graphic design support to the Division of 
Communications.  

High-resolution images that you would like included in your product should be sent as a 
separate attachment to your request. If you need assistance finding appropriate high-resolution 
images, the Division of Communications can help you select an image from our image libraries. 
Photos, graphics, or screenshots from the internet often are protected by copyright. The HHS 
Office of General Counsel cautions against using such images. Note: All content for reports, 
documents, fact sheets, certificates, postcards, posters, flyers, and PowerPoints presentations 
must be cleared through your program office directors and relevant subject matter experts prior 
to submitting content to ASPR Office of External Affairs for design and final clearance.  

mailto:ASPRComms@hhs.gov?subject=ASPR%20Templates
mailto:ASPRComms@hhs.gov?subject=ASPR%20Templates
mailto:ASPRComms@hhs.gov?subject=ASPR%20Templates
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Microsoft Templates (Word, PowerPoint, and Outlook) 

Word Reports and Documents Template. The pre-designed reports and documents template 
is preformatted to meet 508 compliance standards. Do not change the font, colors, margins, or 
headers/footers. Perform a last-minute compliance check of your document using the built-in 
Word accessibility tool. On the ribbon, select the Review tab then click on the Check 
Accessibility icon. 

• Reports and Document Cover Template. For a more formal look to longer documents 
and reports, use a pre-designed report cover. Two report cover templates are provided 
(white cover template and blue cover template). Only the title, subtitle, and date may be 
modified on each template. To edit, open template in Adobe Acrobat Pro DC and select 
the Edit tab then click on Edit Text & Images. Add your title then select the File tab and 
Save As. If you don’t have access to Adobe Acrobat Pro or need help editing the title, 
please contact the Division of Communications. Note that the cover template can be 
combined with the pdf version of your document using Adobe’s Combine Files option. 

• Reports and Document Banner Template. For shorter documents, use the pre-designed 
ASPR banner. This banner should be inserted and centered at the top of the first page 
only.   

PowerPoint Template. All PowerPoint presentations for internal and external audiences must 
use the appropriate PowerPoint template: 

• ASPR PowerPoint Template. This template is used for most presentations given by 
ASPR staff.  

• HHS PowerPoint Template. This template is used for most presentations given by HHS 
from multiple OPDIVS or STAFFDIVs. All the information being presented is appropriate 
for public release. 

In addition, an ASPR 101 PowerPoint slide set is available for staff to help emphasize ASPR’s 
mission and key priorities. Contact the Division of Communications for the latest slide deck. Feel 
free to use all or part of the presentation for your purposes. 

Certificate of Appreciation Templates. Appreciation certificates are a great way to let others 
know that you value their time, effort, or hard work. Many ASPR divisions commonly give 
certificates to FTEs, intermittent employees, and contract staff to say thank you for a job well 
done. Two certificate templates are provided (Certificate of Appreciation One and Certificate of 
Appreciation Two). 

Controlled Correspondence (Stationery). ASPR operates within the Office of the Secretary. 
As such, all letterhead, memos, business cards, envelopes, and other stationery are branded at 
the Department (HHS) level. For more information, see the Controlled Correspondence 
Templates section on the ASPR Portal. 

Outlook Template for Email Signatures. Email messages must include the official ASPR 
signature block (see below sample). All font is Arial, 11 pt. Your name is bold in ASPR blue 
(RGB: 21, 81, 151). Your job title is in ASPR blue. All other font is black.  

Contractors will add “(for [Company Name])” after their job title on the same line.  

The ASPR logo is below your personal information. The logo for email signatures is available for 
download from the ASPR Portal Branding Site. ASPR programs may add their direct website 

https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/ASPR%20Reports%20and%20Documents%20Template.docx
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/ASPR%20Cover%20White%20Template-508.pdf
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/ASPR%20Cover%20Blue%20Template.pdf
mailto:ASPRComms@hhs.gov?subject=ASPR%20Templates
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/ASPR%20Banner%20Head%20for%20Shorter%20Documents.jpg
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/ASPR%20New%20PP%20Presentation%20Template%20Final-508.pptx
https://asprportal.hhs.gov/io/ea/communications/branding/Documents/HHS%20logo%20slide%20template%20(002).pptx?Web=1
mailto:ASPRComms@hhs.gov?subject=ASPR%20101%20Slidedeck
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/Certificate%20of%20Appreciation%202021%20-%20v1-508.docx
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/Certificate%20of%20Appreciation%202021%20v2%20-508.docx
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/Certificate%20of%20Appreciation%202021%20v2%20-508.docx
https://asprportal.hhs.gov/io/Correspondence/Controlled%20Correspondence%20Templates/Forms/AllItems.aspx
https://asprportal.hhs.gov/io/Correspondence/Controlled%20Correspondence%20Templates/Forms/AllItems.aspx
https://asprportal.hhs.gov/io/ea/communications/branding/Pages/templates-and-logos.aspx
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link (e.g., aspr.hhs.gov/cip) below the main ASPR website. Any disclaimers are listed below the 
ASPR logo.  

The use of inspirational messages, charming quotes, or unnecessary imagery, such as email 
stationary, is prohibited. The use of ASPR social media icons below the ASPR logo and before 
any disclaimer is optional. The use of gender pronouns next to your name is also optional. 

Jane Doe 
Public Affairs Specialist 
Office of External Affairs, Division of Communications 
Office of the Assistant Secretary for Preparedness and Response 
U.S. Department of Health and Human Services 
 
200 C Street SW 
Room xxxx 
Washington, DC 20204 
xxx-xxx-xxxx (office) 
xxx-xxx-xxxx (cell) 
https://aspr.hss.gov 
 
 

 

Figure 5: ASPR Email Signature Block 

 

Educational Material Templates 

Fact Sheet Template. All fact sheets will be designed using the ASPR fact sheet template. 
Please note that the ASPR fact sheet template is provided as pdf-only file. You will not be able 
to add your content or graphics to the template. To request a branded fact sheet, please contact 
the Office of External Affairs’ Division of Communications. The ASPR’s graphic designer will 
format your fact sheet based on the content submitted and the graphical elements requested.  

Postcard Template. If you do not have enough content to justify a fact sheet, postcards (8.5" x 
5.5" on cardboard stock) are often used. Please reach out to the Division of Communications for 
assistance. 

Flyer and Poster Templates. ASPR's graphic designer is available to help you develop posters 
and flyers. Posters are mainly used to promote an event occurring within our office spaces and 
are sized to fit the standard 24" x 36" poster frame for display on a poster stand (see sample 
poster). Flyers are smaller versions of the posters, usually 11" x 17", placed within offices to 
promote an upcoming activity (see sample flyer). To request a branded poster or flyer, please 
clear your content through your office's procedures, then send your request to the Division of 
Communications. 
 
Social Media Templates. If your office would like to propose social media posts for use by the 
ASPR Division of Communications on our social media channels, please contact Division of 
Communications prior to drafting content. Several social media templates are available; 
template selection depends on the type of content being communicated. Contractors who create 

https://aspr.hss.gov/
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/ASPR%20Fact%20Sheet%20Sample%20Template%202021%20v2-508.pdf
mailto:ASPRComms@hhs.gov?subject=ASPR%20Templates
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/ASPR%20Post%20Card%20Sample%20Template%202021-508.pdf
mailto:ASPRComms@hhs.gov?subject=ASPR%20Templates
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/24x36%20Poster%20Sample-508.pdf
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/24x36%20Poster%20Sample-508.pdf
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/11x17%20Poster%20Template%202021%20Word-508.docx
mailto:ASPRComms@hhs.gov?subject=ASPR%20Templates
mailto:ASPRComms@hhs.gov?subject=ASPR%20Templates
mailto:ASPRComms@hhs.gov?subject=ASPR%20Templates
mailto:ASPRComms@hhs.gov?subject=ASPR%20Templates
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social media postings as part of their contract responsibilities must contact the Division of 
Communications to obtain template artwork. 
 
Virtual Backgrounds 

Microsoft Teams, WebEx, Zoom, and Google hangout meetings are now the norm. This new 
way of meeting presents a new opportunity to create brand awareness – branded virtual 
backgrounds. The ASPR virtual background reduces distractions for the people attending the 
meeting, and is more professional than having your kitchen, living room, and even an 
unorganized office space in the background. No other virtual background is permitted without 
approval from the Division of Communications. Download our tip sheet for more information 
about looking your best during remote interviews and briefings. 

Web Banner 

All ASPR program websites, including the main site at https://aspr.hhs.govv, must prominently 
display the HHS banner at the top of each page on the site and the ASPR logo in the web site 
header or footer. The ASPR logo must link to https://aspr.hhs.gov.  

Social Media Standards 

ASPR manages six social media sites: Twitter, Facebook, YouTube, LinkedIn, Flickr, Instagram, 
We encourage all ASPR staff to follow each. In addition, BARDA and MRC have their own 
social media accounts because of their tailored messaging and highly engaged niche 
audiences. No other ASPR program is permitted to create a separate social media presence 
without prior approval from the Division of Communications. Too many social media channels 
representing one agency can dilute our message and branding leaving users confused about 
which channels to follow. 

Video Production 

ASPR’s Division of Communications works with ASPR staff at the onset of content development 
through production and post production of videos highlighting the ASPR mission and program in 
accordance with ASPA guidelines. Please contact the Division of Communications for video 
assistance.  
 
Exceptions to These Rules 

For guidance on exceptions to these rules, please contact the Division of Communications.. 

Note: ASPR follows the editorial style guidelines provided in the HHS Guide to Document 
Preparation, Office of the Secretary, 2018. Use this resource to develop a well-written, clear, 
and concise document using established standards on word usage, capitalization, and 
punctuation. 

https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/Virtual%20Background.jpg
https://asprportal.hhs.gov/io/ea/communications/branding/DocLib2/10TipsforLookingyouBestduringRemoteInterviews.pdf
https://aspr.hhs.gov/
https://aspr.hhs.gov/
https://twitter.com/asprgov
https://www.facebook.com/asprgov
https://www.youtube.com/c/ASPRgov
https://www.linkedin.com/showcase/hhs-aspr
https://www.flickr.com/photos/asprgov
https://www.instagram.com/asprgov/
mailto:ASPRComms@hhs.gov?subject=Video%20Support
mailto:ASPRComms@hhs.gov?subject=Template%20Exceptions
https://intranet.hhs.gov/sites/default/files/s3fs-public/s3fs-public/2019-04/2018%20Guide%20to%20Document%20Preparation%20by%20Office%20of%20the%20Secretary.pdf
https://intranet.hhs.gov/sites/default/files/s3fs-public/s3fs-public/2019-04/2018%20Guide%20to%20Document%20Preparation%20by%20Office%20of%20the%20Secretary.pdf
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